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Warranty and Service Policy
Product Warranty
DATAQ Instruments, Inc. warrants that this hardware will be free from defects in materials and workmanship under 
normal use and service for a period of one year from the date of shipment. DATAQ Instruments' obligations under 
this warranty shall not arise until the defective material is shipped freight prepaid to DATAQ Instruments. The only 
responsibility of DATAQ Instruments under this warranty is to repair or replace, at its discretion and on a free of 
charge basis, the defective material.

This warranty does not extend to products that have been repaired or altered by persons other than DATAQ Instru-
ments employees, or products that have been subjected to misuse, neglect, improper installation, or accident.

DATAQ Instruments shall have no liability for incidental or consequential damages of any kind arising out of the sale, 
installation, or use of its products.

Service Policy

1. All products returned to DATAQ Instruments for service, regardless of warranty status, must be on a freight-pre-
paid basis.

2. DATAQ Instruments will repair or replace any defective product within 5 days of its receipt.

3. For in-warranty repairs, DATAQ Instruments will return repaired items to the buyer freight prepaid. Out of war-
ranty repairs will be returned with freight prepaid and added to the service invoice.





!   CAUTION  !
READ BEFORE CONNECTING INPUT SIGNALS TO YOUR DI-710

The DI-710 data acquisition device you have purchased and are about to use is NOT an ISOLATED product. This 
means that it is susceptible to common mode voltages that could cause damage to the device. SUCH DAMAGE IS 
NOT COVERED BY THE PRODUCT’S WARRANTY. Please read the following carefully before deploying the 
product. Contact DATAQ Instruments Support at 330-668-1444 for all questions.

This product can tolerate a maximum applied voltage of only ±20V peak without damage. Although you may be cer-
tain that the signal you want to measure is lower than this level, a common mode voltage (CMV) with an unknown 
value may combine with your signal of interest to exceed this ±20V limit. In such instances, the product will be dam-
aged. Verify a CMV does not exist before connecting signals and acquiring data with your device. Use the following 
procedure to check for CMV:

1. DO NOT connect your data acquisition device to the device under test. If the device under test is connected to 
your data acquisition device, disconnect it.

2. Connect your data acquisition device to the appropriate interface on your PC (USB, Ethernet, RS-232 Serial, or 
Parallel Printer Port).

3. Apply power to your data acquisition device, your PC, and the device under test.

4. Use a digital voltmeter to make the following measurements:

a. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition 
device and Signal+ of the device under test. This measurement should not exceed the Full Scale Range of 
your data acquisition device.

b. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition 
device and Signal- of the device under test. This measurement should be at or very near 0 Volts.

c. Measure the voltage (both the AC and DC range) between the ground terminal of your data acquisition 
device and Common of the device under test. This measurement should be at or very near 0 Volts.

5. Should ANY of these measurements exceed their recommendation DO NOT CONNECT SIGNALS to the data 
acquisition device. A common mode voltage may exist that could destroy the instrument. You MUST determine 
the source of the CMV and eliminate it before taking any measurements.

Device 
Under 
Test

Signal + 1

Signal - 2

Common3

Digital Voltmeter

Data
Acquisition 

Device
To PCGround4

1Measured signal is not to exceed the Full Scale Range of your data acquisition device.
2Measured signal must be at or very near 0 volts.
3Measured signal must be at or very near 0 volts.
4Connect to AGnd (Analog Ground) port on DI-710 instruments.
v
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1. Introduction
Congratulations on your purchase of the DI-710 data logger/data acquisition system. DI-710 Instruments feature a 
variety of options—each explained fully in this manual. Options include a USB or Ethernet Interface, PGL or PGH 
gain settings, and Stand-alone capability. Use the table below to determine the options included with your Instrument.

Features
The DI-710 has the following features:

• Multiple Hardware options: USB or Ethernet Interface; PGL or PGH gain settings; and Stand-alone data logger 
Operation capabilities. All options available in any configuration.

• Per channel software-configurable settings: Single-ended or differential input; input gain; and calibration.

• 4,800 samples/second maximum sampling rate—up to 14,400 samples/second when recording to a memory card.

• 0.048 samples/second minimum sampling rate—0.0017 samples/second when recording to a memory card.

• 14-bit A/D converter for high resolution measurement accuracy.

• 16-entry input scan list allows you to scan any sequence of input channels at any available gain.

• The Stand-alone option allows the user to configure a recording session through their PC then record data in the 
field to a memory card (SD) without being connected to their PC.

Analog Inputs
DI-710 models provide 16 single-ended or 8 differential analog inputs (programmable per channel) that allow your 
analog signals to be converted into 14-bit digital data via an on board A/D converter. Two removable 16 position ter-
minal blocks allow you to easily connect and record signals. The DI-710 features the following software-programma-
ble input measurement ranges:

Model No.

Options

Ethernet USB -H Gain -L Gain Stand-alone

DI-710-UH* N Y Y N N

DI-710-UHS* N Y Y N Y

DI-710-UL* N Y N Y N

DI-710-ULS* N Y N Y Y

DI-710-EH* Y N Y N N

DI-710-EHS* Y N Y N Y

DI-710-EL* Y N N Y N

DI-710-ELS* Y N N Y Y

*All DI-710 models available with a 37-pin D sub connector (as opposed to two remov-
able 16-port screw terminal blocks). Add “D” to the model number. See "37-pin D sub 
connector" on page 21.

-L Models -H Models

±10V full scale measurement range at a gain of 1 ±10V full scale measurement range at a gain of 1

±1V full scale measurement range at a gain of 10 ±5V full scale measurement range at a gain of 2
Introduction
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Digital Input and Output
All DI-710models contain 8 software-programmable digital lines (bits) for input/output operations. These lines pro-
vide an interface for the transfer of data between user memory and a peripheral device connected to the instrument. 
Digital inputs can monitor alarms or sensors with TTL outputs, while digital outputs can drive TTL inputs on control 
or measurement equipment. Remote control can be utilized with bits 0 and 1 and is easily accessed using WINDAQ 
Acquisition software or, for stand-alone models, in the stand-alone setup panel. To avoid using an analog input chan-
nel for Digital I/O, Channel 17 may be enabled as the digital channel. To use the Remote Control features in WINDAQ 
Acquisition software either Channel 1 or Channel 17 must be configured as the Digital Input channel.

Software
All software required to record and playback waveforms is included with the purchase of any DI-710 model including 
WINDAQ Acquisition and Playback software and the Dataq Instruments Hardware Manager.

WINDAQ® Recording and Playback Software
WINDAQ Acquisition and WINDAQ Waveform Browser allow you to record and playback data acquired through your 
instrument. Whether using a Stand-alone model or a PC-connected instrument, WINDAQ is an invaluable resource to 
analyzing your data. A special version (see "WinDaq Waveform Browser for SD" on page 30) of WINDAQ Waveform 
Browser (free) is required to read waveform data recorded to a Memory Card but is easily transferred to the standard 
version for more analytical features.

WINDAQ Acquisition software can be used to record waveforms directly and continuously to disk while monitoring a 
real time display of the waveforms on-screen. It operates and displays waveform signals in real time at the full sample 
rate of the instrument being used. WINDAQ (free) is restricted to recording throughput rates of 1108 Hz with a DI-
710. Purchase an Unlock Code to record data at the speed of your data acquisition system. When you install the soft-
ware, a trial version of Unlocked High Speed Software is automatically installed allowing you to record at higher 
rates for a limited time. Activation is required for continued use to ensure compliance with the Software License 
Agreement. This software is accessed through the Dataq Instruments Hardware Manager which can be found in the 
Start menu under the WINDAQ program group called Dataq Instruments Hardware Manager.

WINDAQ Waveform Browser playback software (also known as “WWB”) offers an easy way to review and analyze 
acquired waveforms. A built-in data file translator allows the user to display multiple waveforms acquired by 
WINDAQ Acquisition software or any of a wide range of data acquisition packages. The software’s disk-streaming 
design allows data files of any length to be graphically displayed rapidly, in normal or reverse time directions. Seven 
standard cursor-based measurements, frequency domain, and statistical analysis functions help simplify waveform 
analysis and interpretation. WINDAQ Waveform Browser is free and installed when installing WINDAQ Software.

The DATAQ Instruments Hardware Manager
The DATAQ Instruments Hardware Manager allows you to effectively manage and run multiple instruments installed 
and connected to your PC or your Network—or even over the internet. This software can be found in the Start menu 
under the WINDAQ program group called Dataq Instruments Hardware Manager. Access WINDAQ Acquisition 
software, Upload data from your memory card, check the Status of your memory card, Format your memory card, 
configure a Stand-alone data acquisition session, setup the Digital I/O, and more in this easy-to-use point and click 
environment. View the Help files by clicking on View Help in the Help menu or by pressing F1.

±100mV full scale measurement range at a gain of 100* ±2.5V full scale measurement range at a gain of 4

±10mV full scale measurement range at a gain of 1000* ±1.25V full scale measurement range at a gain of 8

*Gains of 100 and 1000 are limited to max throughput of 7200 and 900 Hz respectively when acquiring more than 
one channel of data.
Introduction
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Help
All WINDAQ software utilizes context-sensitive help. Help may be accessed through the Help menu or by pressing the 
F1 key with any feature selected. This will take you directly to the Help topic most relevant to that particular function 
or feature. Help topics discuss in detail each function available in the software.
Introduction
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2. Specifications

Analog Inputs
Number of Channels: DI-710: 16

Channel Configuration: DI-710: 16 single ended, 8 differential, programmable per channel

Input Impedance, single-ended: 1M

Maximum common mode voltage:

Common mode rejection (DI-710):

Channel-to-Channel crosstalk rejection:

Gain temperature coefficient:

Offset temperature coefficient:

Digital Filtering:

Analog measurement range (software selectable per channel), Accuracy, and Resolution:

Unless otherwise noted, specifications are for all DI-710 instruments.

Input Impedance, differential: 1M each input to common

Input bias current: 10µA for a 10V input, single channel

Input offset voltage: Auto-zero

Input offset current: 2nA (single channel)

Maximum normal mode voltage (DI-710): 30V DC or peak AC

30V DC or peak AC

80db, gain=1, 1Kunbalance

-75db @ 100unbalance

50ppm/°C

0.25µV/°C

PC-connected models: Conditional over-sampling
Stand-alone models: None

DI-710-L Models DI-710-H Models

Gain Range Accuracy* Resolution Gain Range Accuracy* Resolution

1 ±10V ±.05%FSR ±50µV ±1.22mV 1 ±10V ±.05%FSR ±50µV ±1.22mV

10 ±1V ±.05%FSR ±50µV ±122µV 2 ±5V ±.05%FSR ±50µV ±610µV

100 ±100mV ±.05%FSR ±50µV ±12.2µV 4 ±2.5V ±.05%FSR ±50µV ±305µV

1000 ±10mV ±.05%FSR ±50µV ±1.22µV 8 ±1.25V ±.05%FSR ±50µV ±153µV

*Test Condition: Single channel, 100 S/s, averaging mode.

Digital I/O
Channels: 8 bi-directional bits

Configuration: Each bit is programmable as an input or output

Output voltage levels: Minimum “1”, 3V @ 2.5mA sourcing; Maximum “0”, 0.4V @ 2.5mA 
sinking

Output current: Maximum source, -2.5mA; Maximum sink, 2.5mA

Input voltage levels: Minimum required “1”, 2V; Maximum allowed “0”, 0.8V

A/D Characteristics
Type: Successive Approximation
Specifications
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Resolution: 14-bit

Monotonicity: ±2 LSB

Conversion Time: 69µs

Scanning Characteristics
Maximum sample throughput rate:* PC-connected: 4,800 Hz    Stand-alone: 14,400 Hz**

*When acquiring more than one channel at a gain of 100 max throughput is 7200 Hz; 
When acquiring more than one channel at a gain of 1000 max throughput is 900 Hz.

**Dependent on SD card used. Low speed SD cards can sample up to 2,000 Hz; High 
speed cards can sample up to 14,400 Hz. Some high speed cards cannot sample as 
high at 14,400 Hz but their capability can only be determined by trial and error 
(Model 101014-2G has been tested and approved).

Minimum sample throughput rate: PC-connected: 0.0034 Hz    Stand-alone: 0.0017 Hz

Maximum scan list size: 17 entries

Sample buffer size: 2kb

Calibration
Calibration Cycle: One year

USB Interface
Connector: USB

Protocol: USB 1.1

Ethernet Interface
Type: 10/100Base-T

Connector: RJ-45

Protocol: TCP/IP

Server Type: DHCP

Removable Memory (Stand-alone Models only)
Type: Standard Secure Digital (not SDHDor SDxC). Sample rates of 2kHz 

require SD speeds of 133x or higher. Up to 2kHz require speeds of 13x 
or higher.

Capacity: 16MB to 2GB

Real Time Clock
Type: Date, hour, minute, second

Resolution: 1 second

Accuracy: 20 ppm

Controls (Stand-alone Models only)
Single push-button: Provides manual control over Record and Standby modes.
Specifications
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Indicators
Stand-alone models: Three color LED indicating Record, Standby, and Error conditions.

PC-connected models: Power LED

Transfer Rate to PC
Real Time: up to 4,800 samples per second

From SD Memory (Ethernet models 
only):

up to 2,400 samples per second

General
Panel Indicators: Mode LED

Panel Controls: Control push-button (Stand-alone models)

Panel slots: Accepts SD-type flash memory

Input connectors: DI-710: Two, removable sixteen position terminal blocks

Operating Environment: 0°C to 70°C

Enclosure: DI-710: Aluminum base with steel wrap-around. Aluminum end-panels 
with plastic bezels.

Dimensions: DI-710: 5.4 D x 4.1 W x 1.5 H in. (13.81D x 10.48W x 3.81H cm.)

Weight: DI-710: 14 oz. (397 grams)

Power Requirements: DI-710 USB products: 9 to 36 VDC, 2 watts maximum
DI-710 Ethernet products: 9 to 36 VDC, 2.5 watts maximum
Specifications
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3. Installation
Unpacking
The following items are included with each instrument. Verify that you have the following:

• DI-710 Series Instrument.

• Communications cable (USB ONLY - Ethernet models do not come with an Ethernet cable).

• Power cable (except DI-710-UL and DI-710-UH).

• The DATAQ Instruments CD-ROM.

• DATAQ screwdriver for connecting signal leads to the screw terminal(s).

• Installation Guide pamphlet (included in CD case).

If an item is missing or damaged, call DATAQ Instruments at 330-668-1444. We will guide you through the appropri-
ate steps for replacing missing or damaged items. Save the original packing material in the unlikely event that your 
unit must, for any reason, be sent back to DATAQ Instruments.

USB Device Installation
1. Disconnect all DATAQ Instruments USB devices from your Computer.

2. Insert the DATAQ Instruments CD in your drive. The installation software should start automatically within 20 
seconds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root 
of the DATAQ Instruments CD.

3. In the “What do you want to do?” window, select “Install WinDaq Software” and click OK.
Installation
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4. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-
718B(x) instruments” option and click OK.

5. In the “WinDaq Installation” dialog box, select the “Install Software” option and click OK to continue. If you 
wish to view the hardware documentation you may do so now by clicking on the appropriate radio button. Docu-
mentation will be saved to your hard drive during this installation.

6. In the “Welcome!” box, click OK to continue.

7. Read the License Agreement. If you accept the terms, click Accept and Continue. If you choose not to accept, 
click on the Do not accept and stop button to end the installation.

8. When prompted, enter your registration information (name and company) in the appropriate text boxes and click 
OK. Confirm your registration information before continuing.

9. When prompted, specify the directory where you want to install your WINDAQ software. It is recommended that 
you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-
718B instrument be sure to install to the same folder.

10. In the “Select an Interface” box select USB and click OK.

11. DO NOT connect your USB device or cable to your PC until installation is complete. If your device is currently 
connected, please disconnect it before continuing with this installation. Once your device is disconnected, click 
the OK button.

12. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu 
for WINDAQ software icons. It is recommended that you accept the default.

13. In the “Installation Option” dialog box specify whether you want all users to have access to WINDAQ software or 
just the current User. Click Yes to allow all users to have access, click No to allow just the current user to have 
access.

14. After WINDAQ Software installs, you will be prompted to install WINDAQ/XL Trial Version and Advanced 
CODAS Analysis software. If you wish to install either software click on Yes in the appropriate dialog box. Fol-
low the on screen prompts to complete installation.

15. Software installation is complete - you will now see a “Successful Installation” box - click OK to exit WINDAQ 

Installation.

You can now plug the device(s) into your PC and apply power (if required). You do not need to re-install this software 
when installing more DI- 71x USB devices to your PC.

Click on the appropriate program group (specified above — default is Start > Programs > WINDAQ) and click on 
“DATAQ Instruments Hardware Manager” to run WINDAQ software. All DATAQ Instruments software is located in 
the same program group.

Ethernet Device Installation
Install WINDAQ Software and the DATAQ Instruments Hardware Manager. 

1. Insert the DATAQ Instruments CD in your drive. The installation software should start automatically within 20 
seconds. If it does not, start it manually by double-clicking the Setup application (setup.exe) located on the root 
of the DATAQ Instruments CD.

2. In the “What do you want to do?” window, select “Install Software” and click OK.
Installation
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3. In the “Installing Software” window, select the “Install Software for DI-148, DI-158, DI-710, DI-715B, and DI-
718B(x) instruments” option and click OK.

4. In the “WinDaq Installation” dialog box, select the “Install Software” option and click OK to continue. If you 
wish to view the full hardware documentation you may do so now by clicking on the appropriate radio button. 
Documentation will be saved to your hard drive during installation.

5. In the “Welcome!” box, click OK to continue.

6. Read the License Agreement. If you accept the terms, click Accept and Continue. If you choose not to accept, 
click on the Do not accept and stop button to end the installation.

7. When prompted, enter your registration information (name and company) in the appropriate text boxes and click 
OK. Confirm your registration information before continuing.

8. When prompted, specify the directory where you want to install your WINDAQ software. It is recommended that 
you accept the default. If you have already successfully installed a DI-148, DI-158, DI-710, DI-715B, or DI-
718B instrument be sure to install to the same folder.

9. In the “Select an Interface” box select the Ethernet option and click OK to continue.

10. When prompted to Select a Program Manager Group specify a destination (or group window) in the Start Menu 
for WINDAQ software icons. It is recommended that you accept the default.

11. In the “Installation Option” dialog box specify whether you want all users to have access to WINDAQ software or 
just the current User. Click Yes to allow all users to have access, click No to allow just the current user to have 
access.

12. After WINDAQ Software installs, you will be prompted to install WINDAQ/XL Trial Version and Advanced 
CODAS Analysis software. If you wish to install either software click on Yes in the appropriate dialog box. Fol-
low the on screen prompts to complete installation.

13. Installation is complete - you will now see a “Successful Installation” box - click OK to exit WINDAQ Installa-
tion.

Ethernet devices can now be connected to your network or PC. Follow the appropriate instructions in “Installing an 
Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are 
Installed” on page 12 “Installing an Ethernet Device via a Distributed Network Without a DHCP Server” on page 15, 
or “Installing an Ethernet Device via a Distributed Network with a DHCP Server” on page 16 of this manual for your 
specific network connections configuration.

Click on the appropriate program group (specified above — default is Start > Programs > WINDAQ) and click on 
“DATAQ Instruments Hardware Manager” to run WINDAQ software. All DATAQ Instruments software is located in 
the same program group.
Installation
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Installing an Ethernet Device Directly Connected to your PC or Connected 
via a Hub or Switch Where ONLY DI-71x Products are Installed
Installation of an Ethernet device directly connected to the network card on your computer requires you to change the 
IP address of your network card.

Note: When installing an Ethernet device directly connected to your PC you MUST use a crossover cable (provided). 
When using a hub that does not have an auto-switching sensor, you must NOT use a crossover cable.

Note: You MUST disable all wireless connections during installation. Wireless connections can be re-enabled once 
installation is complete.

Installation of an Ethernet device via an Ethernet hub/switch containing ONLY DI-71x products also requires you to 
change the IP address of your network card.

Note: For hubs that do not have an auto-switching sensor (usually older hubs) you must not use a crossover cable.

1. Install software (see “Ethernet Device Installation” on page 10).

1. Find the Network Connections on your computer (usually in the Control Panel).

2. Double-click on the Local Area Connection icon.

3. Click on the Properties button.

Windows XP Windows 7
Installation
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4. Select Internet Protocol (TCP/IP) (in Windows XP) or Internet Protocol Version 4 (TCP/IPv4) (in Windows 
7) in the “This connection uses the following items” window and click on the Properties button.

5. Click on the General tab.

6. Select the radio button Use the following IP address.

7. Enter 169.254.0.1 in the space provided for the IP address.

Windows XP Windows 7
Installation
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8. Enter 255.255.255.0 in the space provided for the Subnet mask.

9. Click on the OK button to close the Internet Protocol (TCP/IP) Properties dialog box then click on the OK but-
ton in the Local Area Connection Properties dialog box for the changes to take effect.

10. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click on 
the Update List button).

NOTE: If you unplug your device and connect your PC to a network or router you should change these settings back 
to their original state.
Installation
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Installing an Ethernet Device via a Distributed Network Without a DHCP 
Server
Installation of an Ethernet device connected to a distributed network that does not have a DHCP server or where the 
DHCP server is turned off requires you to obtain an IP address from your system administrator.

Note: In the illustration above, the Hubs could instead be routers with DHCP turned off (i.e., a static IP assigned net-
work). Contact your system administrator for details about your network.

1. Have the system administrator designate an IP address for your device.

2. Install software (see “Ethernet Device Installation” on page 10).

3. Plug the device into your network and apply power.

4. Open the DATAQ Instruments Hardware Manager software.

5. In the dropdown command list (lower left-hand corner), select Static IP. The Manage IP Addresses dialog box 
will open.

6. Click on the MAC address of your device in the list of displayed MAC addresses (the MAC address of your 
device can be found on the silver sticker located on the bottom of your device).

7. Enter the IP address your system administrator assigned to you in the New IP Address text boxes.

8. Click on the Set Static button. Your device will appear in the list of available devices in the main DATAQ Instru-
ments Hardware Manager window. It may take more than 15 seconds for your device to appear in the list. If you 
get a “No Devices Found” error after following the above instructions, click the Update List button until the 
device appears in the list.

Note: These instructions change the settings inside the device. If you move the device to a DHCP-enabled network 
(i.e., where IP addresses are assigned automatically by a DHCP server or router) you will need to change the device 
settings using the DATAQ Instruments Hardware Manager. See the DATAQ Instruments Hardware Manager help file 
for complete details.
Installation
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Installing an Ethernet Device via a Distributed Network with a DHCP Server
Installation of an Ethernet device connected to a distributed network that has a DHCP server (i.e., a DHCP router 
automatically assigns IP addresses to each device connected to the network) requires no extra setup (i.e., it is a “plug 
and play” device).

Note: If you are unsure whether your network is DHCP-enabled or not, check with your system administrator before 
installing WINDAQ.

1. Install software (see “Ethernet Device Installation” on page 10).

2. Connect your Ethernet device to your Local Area Network.

3. Apply power to the device.

4. You will now be able to see the device in the DATAQ Instruments Hardware Manager (you may have to click the 
Update List button).

Activation of WINDAQ/High Speed Option
Activation is required for continued use of WINDAQ/HS (High Speed option) to ensure compliance with the Software 
License Agreement. The Software License Agreement can be found in the WINDAQ Software manual or in the 
WINDAQ program group (License.txt). The WINDAQ/HS may be activated through the Help menu by clicking on 
Unlock WINDAQ/HS or by waiting for the trial version to expire. Trial versions are good for 40 High Speed (over 
1108 Hz throughput) recording sessions. The High Speed version may be purchased after the trial period expires 
through our online store or by phone. For help or for questions regarding Activation and/or the Software License 
Agreement, contact DATAQ Instruments Customer Support.

Dataq Instruments Hardware Manager
The Dataq Instruments Hardware Manager is installed when installing any DI-710 instrument. This software allows 
you to effectively manage and run multiple instruments installed and connected to your PC or your Network—or 
even over the internet. WINDAQ Data Acquisition Software and the Stand-alone Set Up program are both accessed 
Installation
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through the Dataq Instruments Hardware Manager. The Dataq Instruments Hardware Manager may be accessed 
through the Windows Program Manager Group as specified during installation (default is Start > Programs > 
WINDAQ > Dataq Instruments Hardware Manager). All available devices will automatically appear in the list box 
when you run the software. For help with the Dataq Instruments Hardware Manager access the Help Files using either 
the Help menu item or by pressing the F1 key to access context-sensitive help.
Installation
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4. Instrument Controls,         
Indicators, and Connections
Connecting the DI-710 to Ground

! IMPORTANT !

The ground connection on the I/O terminal strip should always be connected to a signal ground, if one is not inher-
ently made through analog or digital signal connections. Without this connection, the front end of the DI-710 does not 
have a return path which could lead to inaccurate measurements. Under no circumstances should the DI-710 be used 
in a measurement situation where it will experience common mode voltages in excess of ±30 VDC or peak AC (the 
device’s full-scale range without damage).

The ground lug at the rear of the DI-710 should always be connected to a solid chassis or earth ground. This connec-
tion is mandatory for the unit to meet CE guidelines.

I
S
O
L
A
T
I
O
N

DATA DATA

POWER POWER

DI-710
Front End

Interface
USB/Ethernet

SD Memory
Card

Digital I/O

Analog Inputs

Rear Panel 
Ground Lug

To signal ground
(if not inherently 

made through 
analog or digital 

connections).

Solid Chassis or 
Earth Ground 
Connection

Two Critical DI-710 Ground Connections

Analog Ground 
Connection
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Instrument Front Panel
The 32 port screw terminal access connector is used to interface analog input channels 1 through 16 and the eight dig-
ital bits. Use the sticker located on the top of your instrument for quick reference to terminal access port designations. 
Designations are explained in full detail here.

DI-710 Series instruments can accept 16 analog inputs in single-ended configuration or 8 analog inputs in differential 
configuration. Single-ended inputs are configured by connecting one signal lead to the desired channel and the other 
signal lead to analog ground (AG). Be sure to read “CAUTION” on page v before connecting input signals.

0 1 2 3

4 5 6 7

Digital Input/Output DGnd +5V R AGnd Analog Channels

These two ports 
are designated 
Digital Grounds

These two ports 
are Reserved

The 8 digital bits may be accessed 
through these ports.  Each port is 
programmable as Digital In or Digital 
Out.  Use Digital port 0 for Remote 
Start/Stop and Digital port 1 for 
Remote Event Markers.

These two ports 
are designated 
+5V Power
Max Current = 
100mA

These two 
ports are 
designated 
Analog 
Grounds

16 Analog Channel ports (8 differential) for analog input.  
The top row of channels (1-8) are designated positive 
differential and the bottom row of channels (9-16) are their 
negative counterparts.

1 2 3 4

9 10 11 12

5 6 7 8

13 14 15 16

Diff
+

-

1 2 3 4

9 10 11 12

5 6 7 8

13 14 15 16

Digital Input/Output
0 1 2 3

4 5 6 7

DGnd +5V R AGnd Analog Channels

Signal Ground
Signal +

Channel 1 configured for single-ended input
Instrument Controls, Indicators, and Connections
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Differential inputs occupy two channels with the lowest numbered channel in the pair assuming the positive (+) input 
and the channel number. Refer to the following for differential pairs.

For example, to configure Channel 1 as a differential input: Connect Channel 1 as the positive (+) input and channel 
9 as the negative (-) input—the pair is referred to as “channel 1 differential.” The following illustration shows chan-
nels 1 and 9 configured as channel 1 differential.

37-pin D sub connector
The two removable 16-port screw terminal blocks may be replaced by a 37-pin D Sub Connector for all DATAQ 
Instruments DI-710 Series products (add a “D” to the model number). Refer to the following diagram for pin out.

Note: Digital I/O connections cannot be used concurrently. DI0 and DO0 are directly connected inside the DI-710 
(as are DI1 and DO1, DI2 and DO2, etc.).

Refer to “7. Accessories” for accessories that can be used with the 37 pin D sub connector.

1 2 3 4

9 10 11 12

5 6 7 8

13 14 15 16 negative differential channels

positive differential channels

differential pairs

Digital Input/Output
0 1 2 3

4 5 6 7

DG +5V R AG Analog Channels
1 2 3 4

9 10 11 12

5 6 7 8

13 14 15 16

Channel 1 configured for differential input

Optional Ground (shield)
Signal +

Signal -
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Instrument Rear Panel
The Rear panel of your DI-710 Model can vary depending on your model. Stand-alone models add a removable stor-
age slot, the LED Mode table, and a Control Button.

See “Controls and Indicators” on page 23 for a full explanation of each component.

Connecting Signals
Use the removable screw terminal blocks to connect your signals.

1. Insert the stripped end of a signal lead into the desired terminal directly under the screw.

2. Tighten the pressure flap by rotating the screw clockwise with a small screwdriver. Make sure that the pressure 
flap tightens only against the signal wire and not the wire insulation. Do not over-tighten.
Instrument Controls, Indicators, and Connections
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3. Tug gently on the signal lead to ensure that it is firmly secured.

When an input signal is connected and WINDAQ Acquisition software is run, WINDAQ’s real time display immedi-
ately reveals the input waveform on your computer’s monitor.

Controls and Indicators

Power Input Jack
For Ethernet models and Stand-alone models. Power must be applied with the included power adapter or with an 
alternate appropriate source (9-36 VDC, 2 watts max). External power is not required for DI-710-UH and DI-710-UL 
models—Power is derived through one of your PC’s USB ports or through a powered USB hub.

Ground
This ground lug should always be connected to a solid chassis or earth ground. This connection is mandatory for the 
unit to meet CE guidelines.

Interface Port
The Interface port allows you to connect the instrument to your PC via USB or Ethernet cable.

Control Button (Stand-alone Models)
The Control Button can be used to stop or start recording data to your memory card (SD) when using the instrument 
as a stand-alone data logger. The Control Button can also be used to reconfigure the instrument to factory default set-
tings and to re-format memory card files left open due to power failure or other circumstance. The Control Button is 
inoperable while running WINDAQ Acquisition software.

Start Recording
To Start recording data to your memory card the Instrument must be in Standby Mode (Mode LED is Green). Press 
and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. The Mode 
LED will rapidly blink green to indicate the instrument is creating a new file. When the Mode LED slowly blinks red, 
data is being recorded. Each subsequent recording session creates a new file (numbered sequentially).

Stop Recording
To Stop recording data to your memory card the Instrument must be in Record mode (Mode LED is flashing red @ 1 
Hz). Press and hold the Control Button until the Mode LED turns off (about 1 second). Release the Control Button. 
Mode LED will rapidly blink red to indicate the instrument is closing the data file for use with playback and/or anal-
ysis software. Do not remove the memory card before the instrument completely closes the file. When Mode LED 
turns green the memory card may be removed. Removing the card before completion will cause Error Mode (Mode 
LED is orange).
Instrument Controls, Indicators, and Connections
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Note: SD cards should be locked before inserting into a card reader. Your PC may try to change the flash card format 
whenever it reads the data on your SD card (if not locked), causing it to lose the unique formatting required for DI-
710 use. If the unique format used by the DI-710 is modified, the data logger may require you to reformat the memory 
card.

Formatting the Memory Card
Formatting the card completely removes all data. To format your memory card the instrument must be in Standby 
Mode (Mode LED is Green). Press and hold the Control Button until the Mode LED turns red (about 5 seconds). 
Release the Control Button. The Mode LED will blink red to indicate the Instrument is formatting the card. When the 
Mode LED changes back to green, formatting is complete. Mode LED should be green to indicate successful comple-
tion. Formatting is for use with the instrument used to format the card. To use a memory card with a different instru-
ment you will have to reformat the card.

Reconfigure Instrument
To configure your instrument to the default factory data acquisition session settings press and hold the Control Button 
during power up (i.e., while plugging the instrument in). Mode LED will flash bright green then dim to indicate that 
the instrument is configured. Release the Control Button. The default settings are: 16 channels enabled as single-
ended inputs; 300 samples per second per channel sample rate; gain setting of 1 for each channel.

Fix Errors
The Control Button can also be used to fix some common operating errors. When the instrument is in Error mode, 
some action must be taken to fix the error before you can use it. Generally, the Control Button can be used to make 
the instrument operational. See the Error mode in “Mode LED Indicator” on page 25 for more information.
Instrument Controls, Indicators, and Connections
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Mode LED Indicator
Indicates what mode the instrument is currently in. Use the chart on the rear panel of the instrument for quick refer-
ence. Use the table provided below for a more detailed description of each available state.

Removable Storage Slot (SD) (Stand-alone Models)
Use any standard Secure Digital Card (SD) from 16MB to 2GB. Push card completely into slot. Press to release 
(eject) memory card when recording is complete. Please note that some memory cards may not be fast enough for the 
instrument. SD memory cards are available through the DATAQ web site (www.dataq.com) as are SD card readers 
(manufacturer varies).

State Mode Description

Stand-alone data logger operation

Static Green Standby Instrument is powered and available for data acquisition operations. Memory card 
may be safely removed.

Flashing Green Busy Indicates the instrument is busy. Do Not Remove Memory Card.

Orange Error Possible errors include, but are not limited to:

SD removed prematurely: Memory card removed before the instrument had a 
chance to close the data file. Reinsert the card and Press the Control button to close 
the file. When steady green, memory card is closed and can be removed safely.

SD Lock: After initially pressing the Control button to begin recording data, two 
series of blinking Orange before reverting back to Green indicates that the memory 
card is locked. Use another card or unlock the current one. One series of blinking 
Orange before reverting back to Green indicates that the memory card is incompatible 
for use with the instrument. Use the recommended memory card available through 
DATAQ Instruments, Inc.

See also “Troubleshooting” on page 29.

Slow Flashing 
Red (@ 1Hz)

Record Indicates the instrument is acquiring and recording data to your memory card. Do Not 
Remove Memory Card.

Fast Flashing 
Red

Close Indicates the instrument is closing the recording session. Do Not Remove Memory 
Card. Each recording session must be completed before removing the card.

PC-connected operation

Slow Flashing 
Red (@ 1Hz)

Record Indicates the instrument is running and acquiring data for display and/or recording to 
disk. Occurs when WINDAQ Acquisition is running.

Green Standby Indicates WINDAQ has been deactivated and the instrument is in Standby Mode. The 
Mode LED Indicator will also flash green just before recording to disk to indicate ini-
tialization.
Instrument Controls, Indicators, and Connections
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5. Operation
PC-connected Models
PC-based models (non-Stand-alone) are operated and controlled using WINDAQ Software. To begin displaying data 
on your monitor, make sure all wires and cables are properly connected and start WINDAQ Acquisition by pressing 
the Start WINDAQ button in the Dataq Instruments Hardware Manager (see “Dataq Instruments Hardware Man-
ager” on page 16). After data is recorded, use WINDAQ Waveform Browser to review your data. Consult the context-
sensitive help files or your Fast Start WINDAQ Software Manual for directions on using the WINDAQ software pack-
age. Note: If your USB module experiences frequent lock ups connect the Ground Lug to your PC ground. If the prob-
lem persists please contact Technical Support.

Enabling/Disabling the Digital I/O and Remote Control
To use the Remote Control features in WINDAQ Acquisition Software Channel 1 or Channel 17 must be enabled as 
the Digital Input channel. In order to use all 16 analog input channels, Channel 17 may be enabled for general pur-
pose digital I/O functions. The direction of the digital bits must be set in the DATAQ Instruments Hardware Manager 
using the Digital I/O Setup command. The default state from the factory is that all digital bits are set as Inputs with a 
High signal (+5V).

Stand-alone Models
Stand-alone Models can record data directly to a Secure Digital Card (SD) as well as record data to a PC. When con-
nected to a PC, data recording sessions may be configured and data may be acquired using WINDAQ Acquisition soft-
ware (just the same as if the model were a PC-based instrument). This makes all the features of WINDAQ Acquisition 
software available including triggering, user annotation, user commented event markers, appending, and stop/pause 
data recording (stand-alone data logger operation does not support these features).

When taking your stand-alone model out into the field to use as a stand-alone data logger, you can record data to an 
SD without the use of a PC. Data sessions can be configured for a specific job using the included configuration soft-
ware (installed when WINDAQ is installed). All data recorded to the memory card is fully WINDAQ compatible and 
can be converted then reviewed and analyzed with WINDAQ Playback software.

PC-connected operation
The DI-710 Instrument enters PC Operation Mode when the instrument is connected to the PC and the user initiates 
WINDAQ Acquisition software. As soon as PC Operation Mode is entered, the Control button is deactivated and all 
the features of WINDAQ Acquisition Software are accessible. Consult the context-sensitive help files or your Fast 
Start WINDAQ Software Manual for directions on using the WINDAQ software package.

Note: When running WINDAQ Acquisition software over the internet, unpredictable latencies may occur, especially at 
higher sample rates. The unit generally will continue to acquire data after a latency - but there will be gaps in your 
data.

Networked operation as a data acquisition server
The Ethernet option allows data access from anywhere on a local area network (LAN) or DHCP server. A DI-710 
configured for Stand-alone operation and an Ethernet interface transparently becomes like any other computer on the 
network, able to share data whenever and wherever it is needed. This can be over the LAN to a PC on the other side 
of the facility, or over the Internet to a PC on the other side of the world. Furthermore, Stand-alone instruments can be 
easily added to existing networks. Its server functionality means that it does not require a dedicated network to oper-
ate efficiently. Data is locally stored to SD memory, where it is available for upload (using the Uploader software) 
only on demand and as network bandwidth permits. In this manner, Stand-alone instruments with Ethernet interfaces 
are fully compatible with the intrinsic non-preemptive nature of Ethernet networks.
Operation
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Stand-alone data logger operation
Use your Stand-alone model as a stand-alone data logger to record a WINDAQ-compatible waveform file onto a 
Secure Digital Card (SD). After recording, insert the memory card into your card reader to access the data file. The 
data file can then be opened with WINDAQ Waveform Browser Software for SD allowing analysis and review fea-
tures. See “WinDaq Waveform Browser for SD” on page 30 for more information regarding WINDAQ Waveform 
Browser for SD software.

Data may be recorded using a circular FIFO memory configuration allowing you to record data nearly indefinitely or 
in a non-circular configuration allowing you to stop recording when your memory card is full. Select the desired 
memory configuration using the Stand-alone Set Up software inside the Dataq Instruments Hardware Manager.

Note: SanDisk SD memory cards have a lifetime expectancy of about 100,000 write actions. Each time data wraps 
you will use one write action; each singular data file uses two write actions (start and stop). If used properly a mem-
ory card will last years. See your memory card’s specifications to determine lifetime expectancy.

The Stand-alone Set Up Panel
The Stand-alone Set Up software (installed with WINDAQ—accessible in the WINDAQ program group through the 
Dataq Instruments Hardware Manager) allows you to customize each data recording session before taking the instru-
ment out into the field. The default settings (i.e., if you do not configure the instrument) are 16 single-ended channels 
enabled at 300Hz sample rate and a gain of 1. The default configuration can be reset at any time on the instrument by 
holding the Control button in when applying power. Context-sensitive Help is provided within the configuration soft-
ware. Press F1 to access Help topics related to the currently displayed feature. You must run the software with the 
device properly installed and connected to your PC.

Operation
To use your instrument as a stand-alone data logger follow these steps:

1. Configure the Instrument using the Set Up software or by re-setting to the default (See “The Stand-alone Set Up 
Panel” above).

2. Connect signal leads (See “4. Instrument Controls, Indicators, and Connections” on page 19.).

3. Apply Power to the instrument using the supplied Power Cable.

4. Insert the Secure Digital Card (SD) into the Removable Storage Slot.

5. If the memory card has not been used with your instrument, format the memory card to begin recording data. See 
“Formatting the Memory Card” on page 24.

6. To Record Data to memory card: Press and hold the Control Button until the LED light turns off; release the Con-
trol button to initiate the recording session—initialization could last up to 30 seconds depending on memory card 
used. For Ethernet models you may also use the Start Recording to SD Memory command in the DATAQ Instru-
ments Hardware Manager. This creates a new file numbered sequentially on the memory card. See also “Start 
Recording” on page 23.

7. To Stop Recording Data to memory card: Press and hold the Control Button until the LED light turns off; release 
the Control button to end the recording session and close the data file. It could take up to 30 seconds to close the 
file depending on the memory card used. For Ethernet models you may also use the Stop Recording to SD Mem-
ory command in the DATAQ Instruments Hardware Manager. See also “Stop Recording” on page 23.

8. Access SD data using the uploader software provided in installation (Ethernet models) or by removing the mem-
ory card and using a card reader. Data files open in WINDAQ Waveform Browser for SD (see “WinDaq Wave-
form Browser for SD” on page 30).
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Note: To read the data files, SDs should be locked before inserting into a card reader. If the SD is not locked, 
Windows may modify the file system and the SD will be unreadable to your instrument requiring you to reformat 
the card. some cards may require you to reformat every time you review the data.

Troubleshooting
Use the following chart for errors and resolution.

Problem Possible Cause(s) Resolution

When attempting to initiate a 
recording session the LED blinks 
green for about 5-10 seconds then 
quickly blinks orange then back to 
green.

Memory card not inserted. Press memory card firmly into the 
slot until you hear a slight “click” 
to indicate proper insertion.

When attempting to initiate a 
recording session, LED blinks 
orange, then turns green.

SD is locked (write protected). Unlock the SD Card

Memory card is full. Reformat the memory card.

Memory card is unusable or damaged. You need a new memory card

Recording is initiated but only 
runs for a short time when LED 
blinks orange and stays orange.

Memory card read/write speed in SPI 
mode is too slow to record data as 
specified.

Try lowering the sample rate first.

If problem persists purchase a new 
card (recommended: Lexar Profes-
sional 133X 2 Gigabyte Secure 
Digital Flash Memory).

Recording is initiated in Circular 
Memory configuration, but when 
the file attempts to wrap, the LED 
blinks orange and stays orange.

Memory card read/write speed in SPI 
mode is too slow to record data in cir-
cular memory configuration.

LED is green but I cannot format a 
memory card.

The instrument is looking for a file 
that has not been closed (possible due 
to power failure).

Reinsert the correct memory card 
and press the control button for 
about 1 second (until LED turns 
off) and release. The instrument 
gives you three chances to find the 
correct file, if it does not you must 
format whatever card is there to 
begin a new recording session.

Mode LED will not change from 
error state (orange).

This can be caused by switching 
memory cards during a power failure 
without giving the instrument a 
chance to close the data file.

Remove the memory card and 
unplug the device. Restore power 
to the device (LED should turn 
green). Press and hold the control 
button for about 1 second (until 
LED turns off) and release. If LED 
is orange, press it again. When 
LED turns green reformat your 
memory card.

When memory card is inserted 
into a reader a “not formatted” 
error is seen.

Dependent upon the reader being 
used.

Sometimes the driver for an SD 
card reader appears “dead.” 
Reboot your PC.

When attempting to read the mem-
ory card using a card reader, the 
PC takes an interminably long 
time to open the data.

Dependent upon the memory card, 
card reader, and the PC you are using. 
The amount of time it takes to open 
the card will vary.

Using the Lock feature on an SD 
could speed up the process. Be 
sure to try that before purchasing 
new equipment.
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If power down occurs unexpectedly while recording to SD
The Stand-alone models have a built-in file protection feature. If power is lost while recording, all data—prior to up 
to 255 samples from the power failure—is available. If power is lost for any reason, the data file will be closed and 
saved and a new data file will be started when power is restored (Mode LED will flash red @ 1 Hz) if that option is 
selected in the Hardware Manager Stand-alone setup.

If the memory card is full, the Mode LED will quickly flash orange and then green and will not record new data until 
reformatted. Circular memory configuration may still be used if the memory card has not started to wrap the data (i.e., 
as long as the card is not full) and will only wrap data in the available space.

When recording at low sample rates be aware that the memory card must acquire 256 samples before it actually com-
mits them to memory. For example, if you are recording one channel at 1 sample per second and power down occurs 
unexpectedly, you could lose up to 255 seconds (4 minutes and 15 seconds) of data (255 samples). Use the following 
formula to determine the maximum amount of data loss at power failure.

Note: Clean and solid power on/off (no slow charging and no ringing) required for new file on power interruption. 
Once power is on, power interrupt cannot happen again within 5 seconds. If persistent failure upon power interrup-
tion occurs, consider a universal power supply (UPS).

Note: Switching memory cards before power is restored is not suggested because the data logger will automatically 
attempt to close the file. Leave the memory card in until power is restored, then allow the instrument to close the data 
file. After a new file has begun, stop recording. The memory card may now be removed and read for analysis.

WINDAQ Waveform Browser for SD
All files recorded in Stand-alone data logger operating mode (data saved to SD—.wdc files) must be reviewed in 
WINDAQ Waveform Browser for SD. Data files recorded using WINDAQ Acquisition software (PC operation—.wdq 
files) must be reviewed in the standard WINDAQ Waveform Browser. Even if connected to a PC, WINDAQ Waveform 
Browser cannot eavesdrop on the data being recorded to your memory card. Recording must be stopped and the file 
must be closed to review the data.

After viewing data files through a 
card reader, upon initiating a 
recording session, the LED blinks 
orange then turns green.

The instrument has a unique file sys-
tem. When the data on the memory 
card opens in Windows, sometimes 
Windows will modify the file system.

You must reformat the card. To 
prevent further instances of this 
error, use the Lock provided on 
your SD card. Some cards require 
you to reformat the card with each 
subsequent use.

When attempting to read the mem-
ory card using a card reader, the 
data file is huge (completely fills 
up the memory card) and the 
actual waveform data is difficult 
to find.

The instrument did not have a chance 
to properly close the file.

If you have not started using the 
instrument with a different mem-
ory card, reinsert the card and 
press the LED for about 1 second 
(until LED turns off) and release. 
The LED should be green indicat-
ing the file is closed and can be 
read.

If you have already configured and 
used the instrument again, the file 
can no longer be closed and you 
will have to search for it and cut/
paste the data into a new file.

255
Throughput Rate
---------------------------------------- Seconds of data that COULD be lost=
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DI-710 stand-alone data loggers place 256 equally-spaced event markers into all data files when recording to SD. 
This allows easier navigation through larger files. Click on Event Markers in the View menu to access and “jump 
to” each of these event markers.

The Calculate command in the File menu is unavailable in WINDAQ Waveform Browser for SD. Use the Save As... 
command in the File menu to save data to another format in order to perform Advanced CODAS calculations (File > 
Save As... > option 8) CALC is still available). Converting data from a .wdc format to a .wdq format is also possible 
with File > Save As.... Choose option 2) Binary (with CODAS header) and enter a file name with .wdq as the exten-
sion. For more information regarding the Save As... function, consult your WINDAQ Waveform Browser Help File.

A stand-alone data file acquired with remote events or storage enabled displays an hourglass when opening while it 
scans for event marks and timestamps in order to construct an Event Marker table. Use File Save or the "Save All" 
button when changing files or exiting to write the Event Marker table to the file and avoid a delay when the file is 
opened again.
Operation
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6. Block Diagram
Block Diagram
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7. Accessories
The DI-705 (for use with DI-710 “D” models)
The DI-705 plugs into the 37-pin D sub connector of the front panel of DI-710 “D” models (see “37-pin D sub con-
nector” on page 21) and provides convenient screw terminal access to analog inputs, analog outputs, and the Digital I/
O. Note: The digital I/O is not available in stand-alone mode. The screw terminals accept 16-22 gauge wire and each 
is silk-screened with the corresponding “D” connector pin number (see “37-pin D sub connector” on page 21). The 
DI-705 also features a 37-pin male “pass-through” connector, which allows you to connect our BNC cable (model 
number CABL-4), or our 5B back plane cable (model number CABLE-1), or any 37-pin DAS-16 compatible cable to 
the DI-710 while still allowing screw terminal access.

Any combination of single-ended or differential channels may be connected to the DI-705, but keep in mind a differ-
ential channel uses two analog inputs. Configure single-ended and differential channels on the DI-705 the same way 
as on the DI-710. See “Instrument Front Panel” on page 20 for more information.
Accessories
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The DI-205 (for use with DI-710 “D” models)
The DI-205 is a termination panel for general purpose input and output. The DI-205 along with the supplied cable 
provides a convenient way to interface the Digital I/O, analog output, and analog input signals to DI-710 Series “D” 
models (see “37-pin D sub connector” on page 21). Signal connection is via terminal strip for digital and analog out-
put signals, or 5-way binding posts (banana jacks) for analog input signals.

Input/Output Panel Interconnections

CHAN. 1 CHAN. 2 CHAN. 3 CHAN. 4 CHAN. 5 CHAN. 6 CHAN. 7 CHAN. 8

S. GND S. GND S. GND S. GND S. GND S. GND S. GND S. GND

S. GND S. GND S. GND S. GND S. GND S. GND S. GND S. GND

CHAN.9(1) CHAN.10(2) CHAN.11(3) CHAN.12(4) CHAN.13(5) CHAN.14(6) CHAN.15(7) CHAN.16(8)
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Digital I/O - Analog Output

Dif.

-

+

Digital I/O - Analog Output
The 20 position screw terminal block (labelled Digital I/O - Analog Output) provides access to the Digital I/O ports 
of the 37-pin D sub connector. Note: Digital I/O connections cannot be used concurrently. DI0 and DO0 are directly 
connected inside the DI-710 (as are DI1 and DO1, DI2 and DO2, etc.) The Digital I/O is not available in stand-alone 
mode. See “37-pin D sub connector” on page 21 for pinout.

DAC1 and DAC2 are Reserved ports and should not be used.

VOUT connects to the +5VPWR pin. See “37-pin D sub connector” on page 21 for pinout.
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Input Signal Configuration
Each DI-205 may be configured to connect to 16 single-ended or 8 differential channels. In addition, any combination 
of single-ended or differential channels may be applied. A differential channel is configured by using two single-
ended inputs. Use the following illustration for input connections.

Note that when an input channel is configured for differential operation, the binding post associated with that chan-
nel's high (+) input assumes the channel number.

Connecting a Single-ended Amplifier
A single-ended amplifier is the most straightforward approach to connecting signals to the DI-205. However, to 
derive adequate performance, the use of a single-ended amplifier requires that the signal to be measured is relatively 
high level (greater than or equal to 1V full scale), and the distance from the signal source to the DI-205 is relatively 
short (less than 15 feet). Assuming these conditions exist, a single-ended amplifier may be connected according to the 
diagram below.

CHAN. 1

S. GND

S. GND

CHAN.9(1)

Signal Leads

Channel 1 configured
for single-ended input

CHAN. 1

S. GND

S. GND

CHAN.9(1)

Signal Leads

Channel 1 configured
for differential input

+ input

- input

(-)

(+)

1 of 16 analog grounds

1 of 16 analog inputs

Signal
Source

DI-205
Terminal Strip
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Connecting a Differential Amplifier
A differential channel configuration is a special case approach to signal measurement that should be used with all 
low-level measurements (less than 1v) or when the signal to be measured is located far away from the DI-205 (greater 
than 15 feet). When in a differential operating mode, the instrument sees the difference in voltage between the high 
(+) and low (-) inputs. Differential amplifiers have the advantage of reducing common mode voltages (those appear-
ing simultaneously and in phase on both inputs). This capability may be leveraged to greatly reduce noise riding on a 
signal of interest.

Two signal measurement conditions govern the configuration of a differential channel input: The signal to be mea-
sured is ground-referenced; or the signal to be measured is isolated from ground.

Ground-referenced Signal Sources
A ground-referenced signal source is one with a local ground that may not be (and probably is not) at the same poten-
tial as the computer's ground. This potential difference between signal ground and computer ground is referred to as a 
common mode voltage and is caused by a number of different factors.

The most common of these is different physical locations of the computer and signal ground points. Since wire is not 
a perfect conductor (exhibiting zero resistance regardless of length) a voltage drop, however small, will always be 

V

Signal 
Source

Computer 
Ground

Ground Potential Difference
(Common Mode Voltage)
Accessories
38



DI–710 Series Hardware Manual
present. The differential amplifier is unique in its ability to measure signals originating from sources with different 
ground potentials relative to the computer provided it is connected properly.

The most common error made in connecting differential amplifiers is the tendency to ground both ends of a signal 
shield. This causes current to flow through the shield and induces noise on the signal to be measured. Ensuring that 
only one ground exists on the signal circuit eliminates this problem.

+
Signal
Source

Differential
Amplifier

-

gnd

Signal
Lead
Shield

Ground loop caused by circulating currents.

DI-205 terminal strip

WRONG APPROACH

Circulating currents in signal shield 
induce noise on signal of interest.

+
Signal
Source

Differential
Amplifier

-

gnd

Signal
Lead
Shield

Potential difference
(no path for current to circulate)

DI-205 terminal strip

RIGHT APPROACH

One ground on the signal circuit eliminates 
noise-inducing ground loops.
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Isolated Signal Sources
There are two considerations when connecting a differential amplifier to an isolated signal source: The elimination of 
ground loops as described above, and the use of bias resistors to provide bias current for the differential amplifier's 
positive and negative inputs.

The bias resistors should be chosen to be as low as possible, but the value you use is dependent upon the output 
impedance of your signal source. Generally, the value of the bias resistor should be 10 times the output impedance of 
your signal source or higher. Bias resistors greater than 1M are not recommended.

Signal Cable and the Differential Amplifier
Quick rule-of-thumb: Any application requiring a differential amplifier also defines a need for quality signal cable. 
Four elements combine to ensure adequate quality signal cable: a twisted signal pair with low resistance stranded 
copper conductors; surrounded by a multiple-folded foil shield; with a copper stranded drain wire; all contained 
within an insulated outer jacket.

In applications where such signal cable is used, a dramatic decrease in noise pickup will be experienced. The drain 
wire should be considered as the shield and should be connected as described in “Connecting a Differential Ampli-
fier” on page 38. Signal cable meeting all four criteria for quality is Belden No. 8641.

+
Floating 
Signal
Source

Differential
Amplifier

-

gnd

Signal
Lead
Shield

DI-205 terminal strip

Locate bias resistors as close 
to amplifier as possible

Insulated Outer Jacket Foil Shield
Drain Wire

Twisted Signal Pair

Stranded Copper Conductors
Accessories
40





DATAQ Instruments, Inc.
241 Springside Drive
Akron, Ohio 44333

Support: www.dataq.com/ticket
Telephone: 330-668-1444

Fax: 330-666-5434

Direct Product Links
(click on text to jump to page)

Data Acquisition | Data Logger

http://www.dataq.com/data-acquisition/
http://www.dataq.com/data-logger/

	Warranty and Service Policy
	Product Warranty
	Service Policy

	CAUTION
	Table of Contents
	1. Introduction
	Features
	Analog Inputs
	Digital Input and Output
	Software
	WinDaq® Recording and Playback Software
	The DATAQ Instruments Hardware Manager
	Help


	2. Specifications
	Analog Inputs
	Digital I/O
	A/D Characteristics
	Scanning Characteristics
	Calibration
	USB Interface
	Ethernet Interface
	Removable Memory (Stand-alone Models only)
	Real Time Clock
	Controls (Stand-alone Models only)
	Indicators
	Transfer Rate to PC
	General

	3. Installation
	Unpacking
	USB Device Installation
	Ethernet Device Installation
	Installing an Ethernet Device Directly Connected to your PC or Connected via a Hub or Switch Where ONLY DI-71x Products are Installed
	Installing an Ethernet Device via a Distributed Network Without a DHCP Server
	Installing an Ethernet Device via a Distributed Network with a DHCP Server
	Activation of WinDaq/High Speed Option
	Dataq Instruments Hardware Manager

	4. Instrument Controls, Indicators, and Connections
	Connecting the DI-710 to Ground
	Instrument Front Panel
	37-pin D sub connector

	Instrument Rear Panel
	Connecting Signals
	Controls and Indicators
	Power Input Jack
	Ground
	Interface Port
	Control Button (Stand-alone Models)
	Start Recording
	Stop Recording
	Formatting the Memory Card
	Reconfigure Instrument
	Fix Errors

	Mode LED Indicator
	Removable Storage Slot (SD) (Stand-alone Models)


	5. Operation
	PC-connected Models
	Enabling/Disabling the Digital I/O and Remote Control

	Stand-alone Models
	PC-connected operation
	Networked operation as a data acquisition server
	Stand-alone data logger operation
	The Stand-alone Set Up Panel
	Operation
	Troubleshooting
	If power down occurs unexpectedly while recording to SD
	WinDaq Waveform Browser for SD


	6. Block Diagram
	7. Accessories
	The DI-705 (for use with DI-710 “D” models)
	The DI-205 (for use with DI-710 “D” models)
	Input/Output Panel Interconnections
	Digital I/O - Analog Output

	Input Signal Configuration
	Connecting a Single-ended Amplifier
	Connecting a Differential Amplifier
	Ground-referenced Signal Sources
	Isolated Signal Sources
	Signal Cable and the Differential Amplifier






<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (Adobe RGB \0501998\051)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness false
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages false
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages false
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages false
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 300
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /ENU ([Based on 'DATAQ Datasheets'] [Based on '[High Quality Print]'] Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /BleedOffset [
        0
        0
        0
        0
      ]
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks true
      /IncludeHyperlinks true
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MarksOffset 6
      /MarksWeight 0.250000
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PageMarksFile /RomanDefault
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
    <<
      /AllowImageBreaks true
      /AllowTableBreaks true
      /ExpandPage false
      /HonorBaseURL true
      /HonorRolloverEffect false
      /IgnoreHTMLPageBreaks false
      /IncludeHeaderFooter false
      /MarginOffset [
        0
        0
        0
        0
      ]
      /MetadataAuthor ()
      /MetadataKeywords ()
      /MetadataSubject ()
      /MetadataTitle ()
      /MetricPageSize [
        0
        0
      ]
      /MetricUnit /inch
      /MobileCompatible 0
      /Namespace [
        (Adobe)
        (GoLive)
        (8.0)
      ]
      /OpenZoomToHTMLFontSize false
      /PageOrientation /Portrait
      /RemoveBackground false
      /ShrinkContent true
      /TreatColorsAs /MainMonitorColors
      /UseEmbeddedProfiles false
      /UseHTMLTitleAsMetadata true
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


